
Print-Tool User Guide 
version 1.1.0 

!!
Print-Tool has been developed by Roy Harrington for those of us wanting to retain control 
over the print process and overcome or master the differing approaches to printing images 
that have been introduced during the last few years by the computer, software and printer 
suppliers such as Apple, Adobe and Epson. !!
PRINT-TOOL FEATURES !

• Position and resize multiple images on a page 
- simple drag and drop images, drag edges and corners 

• Accepts many formats 
- jpg, tif, psd, png, gif 
- 8-bit or 16-bit; RGB or grayscale 

• Print to any print driver 
- QuadToneRIP, Epson, HP 

• Full control of ICC color management 
- Off, Application Controlled, System Controlled 
- Rendering Intents, Perceptual, Relative, Saturation 
- Black Point Compensation 
- Epson ABW supported 
- Soft Proofing 

• Requires Mac OS X with Intel Processor 
- Snow Leopard 10.6.8 - Lion 10.7 - Mountain Lion 10.8 - Mavericks 10.9 !

This guide steps through the stages of using Print Tool to create a print. Throughout this 
Guide one printer - an Epson 4800 - is used to illustrate the print setting options. Every 
printer has different settings and controls but the principle is the same for all printers. Some 
experimentation will be necessary. 
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There is no substitute for experimentation. You have to try things to see how they work and 
to see if they work for you. This guide is NOT written as a recipe for perfect prints using 
Print-Tool. It is written to help you understand the options you have to gain control over 
the printing of your images.

http://www.quadtonerip.com/


WORKSPACE !
The Print-Tool Workspace has two regions, the Page and the Control Panel. The workspace 
can be resized to fill the screen. It is shown here in the User Guide at its smallest proportions. !
The Page !
The left side represents the 
page/paper where images 
will be displayed for 
printing. 
!
!
!
!
!
!
!
!
!
 
!
The Control Panel !
The right side is where all 
of the settings are made 
prior to printing. !
The Print-Tool settings 
region - The Control Panel 
- has four areas referred to 
in this User Guide as Panes 
A, B, C and D. !
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SUGGESTED WORKFLOW !
This section outlines a workflow which will help familiarise you with the operation and 
capability of Print-Tool. It focuses on each of the Panes and the selections available. 
 !
Printer and Page Setup - Pane A !
‘Printer:’ is where you select your printer 
from the drop-down. Only installed 
printers appear here. !
‘Print…’ is covered at the end of this 
section of the guide. It calls up the printer 
driver settings. !
The ‘Paper: Page Setup…’ brings up the window below. Your current settings here can be 
saved as the default in the ‘Settings:’ drop-down. Ensure that the printer in ‘Format For:’ is 
the same as for the printer selected at the top of Pane A. !
Select the ‘Paper Size:’ 
drop-down to choose your 
paper size. For each paper 
size there are further 
options about the print 
area. ‘Orientation:’ selects 
landscape or portrait. 
Always set ‘Scale:’ to 
100%. !
In the ‘Page Size and 
Margins’ choose your 
‘Units’ from ‘inches’, ‘cm’, ‘mm’, ‘points’ or ‘picas’. The three ‘Grid:’ buttons select how the 
grid is displayed in the paper area to the left of the workspace. The values displayed are not 
editable here, they arise from the ‘Paper Size:’ selection and define the intended extent of 
the printable areas. Observe how the extent of the printable area changes for different 
options within a particular paper size.  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Placing an Image or Images onto the Page for Printing - Pane B !
There are two ways to place an image on the page to be printed. 
 

• Select the ‘+’button 
then navigate to the file 
to be loaded: 
File>Open Image. 

• Or drag the image file 
to the page from 
Finder. 

• If you require additional 
images on the same 
page click the ‘+’ 
again. If you require to 
print more than one 
copy of the image, 
select the ‘Duplicate 
Image’ button. !

Your selection(s) will now 
have appeared on the 
page to be printed. !
• Remove an image file by selecting its file name or its image and clicking the ‘-‘ button. 
• Remove all image files by clicking the bottom right button of the set. !!
Sizing and Positioning an Image or Images for Printing - Pane C !
The position and scale of the selected 
image is fully adjustable: !

• by dragging the image to the desired 
position on the page. 

• by dragging any corner or edge to 
resize. 

• by editing the values in the ‘Image 
Position and Scaling’ window in Pane 
C. 

• by using the two ‘Position’ buttons to 
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center the image on the paper or to move the image onto the paper. 
• by using the four ‘Scaling’ buttons to “Scale to Fit’, to ‘Scale to 100%’, or to decrease or 

increase the scaling in steps of 25%. 
• by using either of the ‘Rotate’ buttons. !

Moving or resizing the image on the page or changing any of the values in the ‘Image 
Position and Scaling’ window will automatically cause the other values to be recalculated. 
 
Print Color Management - Pane D !
This is where you make decisions about 
what color management policy you want to 
apply to your printed image. Taking each 
drop-down or button in turn: !
a) Select your Color Management policy.  !
Options are: !

• Application Managed - The ICC profile selected in the drop-down immediately 
below WILL be applied to the print. And, Color Management WILL NOT be applied 
by the printer driver. Selecting ‘Application Managed’ is the equivalent in PhotoShop of 
‘PhotoShop Manages Color’. 

• No Color Management - An ICC profile WILL NOT be applied to the print. If there is 
a profile displayed in the drop-down immediately below it will be grayed out and WILL 
NOT be applied to the print. Also, Color Management WILL NOT be applied by the 
printer driver. And, ‘Intent’ and ‘Proofing’ options are also unavailable (grayed out). This 
is the option to select for printing targets for creating custom ICC profiles and, in the 
case of QTR, for linearizing QTR curves 

• System Managed - An ICC profile WILL NOT be applied to the print. If there is a 
profile displayed in the drop-down immediately below it will be grayed out and WILL 
NOT be applied to the print. Color Management settings selected in the printer 
driver WILL be applied to the print. ‘Intent’ and ‘Proofing’ options are unavailable 
(grayed out). Selecting ‘System Managed’ is the equivalent in PhotoShop of ‘Printer 
Manages Color’. !

b) Select the ICC profile you want to apply to the print. !
The drop-down contains all of the ICC Profiles available in your profiles folder. Select the one 
you want to apply. The option to select a profile is only available if you have selected 
‘Application Managed’ above. 
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!!
c) Select the ‘Intent’ to apply to the print. !
Options are: !

• Perceptual Intent 
• Relative Intent 
• Relative Intent with Black Point Compensation 
• Saturation Intent !

Much has been written about the different ‘Intents’ and under what conditions they are best 
applied - all of which can easily be found on the internet. !
d) Proofing. !
Soft Proofing immediately applies the Print Color Management settings (only available in 
‘Application Managed’ - above) to the representation of the print giving an indication of the 
final look of the print. The value of this check depends on several things including whether 
your monitor is ‘correctly’ profiled. This should only be treated as an indication of how the 
final will print will be rendered. !
The Soft Proofing options here are: !

• No Soft Proofing 
• Soft Proofing 
• Proofing + Ink Black !

‘Ink-Black’ simulates the darkness (dMax) of the black ink. It’s effect is the same as "Simulate 
Ink Black” in PhotoShop. !
e) Epson ABW. !
If your Epson Printer supports Epson’s Advanced Black & White (ABW) for your print, and you 
will be using ABW settings for your print, be it a finished print or a target for profiling, this 
box must be checked. It enables access to the ABW settings in the Epson printer driver. !
f) Negative - Invert and Flip. !
Checking ‘Negative’ simply inverts all data and flips left-right for an ‘emulsion down’ 
negative print. 
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!!
g) 8/16 bit. !
Bit control selection determines the bit depth for the color management computations. The 
bit control options are: !

• Auto 8/16-bit 
• 16-bit 
• 8-bit !

Auto is recommended which uses 16-bit for all color management computations sent to the 
printer driver. Selecting 16-bit in the QTR drivers and Epson drivers will determine the bit 
depth sent to the print driver. !
Selecting 8-bit forces all computations to be 8-bit for time/speed reasons, 16-bit may be 
needed for drivers other than QTR or Epson to force 16-bit to driver. !!
PRINTING !
Once you have made all of the settings click either of the ‘Print…’ buttons at the top or 
bottom of the Control Panel. This brings up the printer driver for your selected printer where 
there are more settings to review before the print is made. This works the same as if you are 
printing directly from any other program such as PhotoShop. !
Make your selections from the printer driver (see EXAMPLES in the next section), load your 
paper in the printer. Hit ‘Print’ - this time the one in the printer driver window - to make your 
print. !!
EXAMPLES !
The next section shows examples of printer driver settings for a selection of different prints. 
The examples don’t cover every facet of your print drivers. Experimentation and testing will 
reveal which selections/options most suit your requirements. !
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Example 1: A Color Print or a Greyscale Print (with ICC Profile)  !
An RGB color image to be printed on 14 x 11 Harman Gloss Baryta Warmtone paper using 
the profile supplied by Harman for the Epson 4800 with the PK black ink 
(HAR_Eps4800_PK_GlossBarytaWarmtone). This example can equally apply to a Greyscale 
print for which an appropriate ICC profile is available. !
This profile has previously 
been installed in the 
correct folder and was 
selected from the drop-
down list in Pane D. The 
original file is 4320x3456 
pixels and is an RGB 16-bit 
file with the Adobe RGB 
(1998) embedded profile. 
This image is to be printed 
in landscape format at full 
size (100%) at 360 pixels 
per inch and is centred on 
the paper. !!!!
 !
Clicking ‘Print…’ brings up the Epson 
4800 printer driver where you will make 
your final print settings. The printer 
driver window overlays the Print-Tool 
workspace. !!
Make your selections from the printer 
driver, load your paper in the printer, 
then hit ‘Print’ - this time the one in the 
printer driver window - to make your 
print. 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The ‘Layout’ drop-down in the printer driver has 8 entries of which only ‘Color Matching’ and 
‘Print Settings’ will be discussed here. You must ensure that all 8 drop-downs are reviewed 
for your selections. !
Color Matching !
This image is to be printed as ‘Application Managed’ (set 
in Pane D) - meaning its ICC profile will be applied to the 
print. This results in ‘ColorSync’ being automatically 
selected with no option to select ‘Epson Color Controls’. 
As no options are available here ‘ColorSync’ and ‘Epson 
Color Controls’ are grayed out. !
Print Settings !
There are two windows here, ‘Basic’ and 
‘Advanced Color Settings’. !
In ‘Basic’, only some of the selections are 
available. Choose the exact paper or one similar 
to what you have. This also will select the type of 
Black ink - PK (gloss) or MK (matte) in the case of 
Epson 4800 UC printers. See the Epson driver 
documentation for additional information if 
needed.  !
This is the equivalent to printing directly from 
PhotoShop where you have selected “PhotoShop 
Manages Colors”. !
Selections in ‘Advanced Color Settings’ are 
disabled. The display here shows your selected 
media type and the ICC profile the printer driver 
“thinks” is correct. This has been overridden by 
your earlier choice of ICC profile. As this is a 
standard printer driver screen it cannot be 
amended to display your actual profile choice.  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Example 2: A Grayscale Print !
A grayscale image to be printed on A2 paper using the QuadToneRIP driver for the Epson 
4800 using Epson UltraChrome inks - QuadToneRIP printer name is Quad4800-UC. !
This example illustrates 
two particular different 
aspects of using Print-Tool. !
1. It is a ‘System 

Managed’ print (Pane 
D). This means that NO 
ICC profile will be 
applied to the print. If 
there is a profile 
displayed in the drop-
down immediately 
below it will be grayed 
out and WILL NOT be 
applied to the print. 
Color Management 
settings selected in the 
printer driver WILL BE 
applied to the print. 
‘Intent’ and ‘Proofing’ options are unavailable (grayed out). Selecting ‘System Managed’ 
is the equivalent in PhotoShop of ‘Printer Manages Color’.  !

2. The printer driver is the QuadToneRIP driver available from Roy Harrington (follow link in 
the footer). It is used, in the context of Print-Tool, in the same way as any other printer 
driver. It has it’s own settings which are illustrated briefly below and are fully explained in 
the documentation accompanying QuadToneRIP. !!
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Clicking ‘Print…’ brings up the Quad4800-
UC printer driver where you will make your 
final print selections. The printer driver 
window overlays the Print-Tool workspace. !
The ‘Layout’ drop-down has 6 entries of 
which ‘Color Matching’ and ‘QuadToneRIP’ 
will be discussed here. You must ensure that 
all 6 drop-downs are reviewed for your 
selections. !!
Color Matching !
This image is to be printed as ‘System Managed’ (set in 
Pane D) - so the ‘Color Matching’ drop-down offers either 
ColorSync profiles or QuadToneRIP settings. In this case 
QuadToneRIP is selected which gives rise to the following 
selection widow under the ‘Print Settings’ drop-down. !!
QuadToneRIP !!
The use of the extensive capabilities of 
QuadToneRIP is covered in detail in the 
documentation that accompanies it. !
Make your selections from the Quad4800-UC 
printer driver, load your paper in the printer, 
then hit ‘Print’ - this time the one in the printer 
driver window - to make your print !!
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Example 3: A Grayscale Patch Target for ICC Profiling !
A 21x4 step random patch 
target to be printed on A4 
Ilford Smooth Pearl paper 
using the QuadToneRIP 
driver on the Epson 4800 
using Epson UltraChrome 
inks - QuadToneRIP printer 
name is Quad4800-UC. An 
image such as this can be 
used to create grayscale or 
RGB ICC profiles for 
specific printer, paper and 
ink combinations. [Creation 
of profiles is not within the 
scope of this guide. It is 
part of QuadToneRIP 
available via the link in the 
footer]. !!
Color Matching !
This image is to be printed as ‘No Color Management’ (set 
in Pane D). This setting is essential for the production of a 
patch file unaltered by any color management; so the 
‘Color Matching’ drop-down options are grayed out and 
unavailable. !!
QuadToneRIP !
The use of the extensive capabilities of QuadToneRIP is covered in detail in the 
documentation that accompanies it. Make your selections from the Quad4800-UC printer 
driver, load your paper in the printer, then hit ‘Print’ - this time the one in the printer driver 
window - to make your print. The previous example has a sample QuadToneRIP driver 
screen. The profile that you will create from measuring the patches above is specifically for 
the combination of printer, paper, ink and settings you have made within the driver. If you 
wish to use alternative settings for your final print you will need to print a 21x4 step random 
patch for each of the alternative settings.  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Example 4: A Grayscale Patch Target printed with ABW for ICC Profiling !
This is a variation on 
Example 3 - a 21x4 step 
random patch target is to 
be printed on A4 Ilford 
Smooth Pearl paper using 
the Epson 4800 driver and 
Epson UltraChrome inks. 
This patch file is to be used 
to make an ICC profile for 
prints utilizing Epson’s 
ABW settings to ‘tone’ the 
final print. To make an ICC 
profile suitable for the tone 
settings required it is 
necessary to check the 
‘Epson ABW Mode’ box (in 
Pane D) to enable the 
settings to be selected in 
the printer driver for 
printing the patch file. !!
Color Matching !
This image is to be printed as ‘No Color Management’ (set 
in Pane D). This setting is essential for the production of a 
patch file unaltered by any color management. In the case 
of ABW however, there is the option to ‘tone’ the print 
using the ABW Color Controls in the driver. Selecting 
‘Epson Color Controls’ here (under the Color Matching’ 
drop-down) enables ABW in the ‘Print Settings’ drop-
down. !
Note: in this example against ‘Presets:’ the settings you make can be named and saved for 
reuse - in this case: ‘ABW - ICC - H4V4 - A4 Tray”.  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Print Settings for ABW !
Under the ‘Print Settings’ are two tabs - 
‘Basic’ and ‘Advanced Color Settings’. !
These are the normal printer driver settings 
for this printer. Under ‘Color:’ select 
‘Advanced B&W Photo’ along with 
whatever other settings you require. This 
will then enable the display of the 
‘Advanced Color Settings’ where again you 
select what you require. In this example 
the print is warmed slightly with an H=4 
and V=4 setting. !
This example is to print a 21x4 step 
random patch target to be measured to 
create an ICC profile. The profile that you 
will create from measuring the patches 
above is specifically for the combination of 
printer, paper, ink and settings you have 
made within the driver. If you wish to use 
alternative settings for your final print you 
will need to print a 21x4 step random 
patch for each of the alternative settings 
and produce the ICC profile to match. !!!!!!!!!!
IMPORTANT: Examples 3 & 4 are both about printing 21x4 step random patch targets 
for creating ICC profiles. Whatever settings you make in the driver (QuadtoneRIP, 
Epson ABW or any other) for printing the patches you should use the same driver 
settings for your final print matched with its ICC profile. Naming and saving settings as 
‘Presets’ is recommended. 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NOTES !
The workflow above is suggested but the actual sequence in which these steps are carried 
out is not important. It is important is that you have made all the selections before hitting the 
final ‘Print’. !
If you have placed more than one image to print on a page then all of the selected settings 
will be applied to each and every image. !!!
COLOR MANAGEMENT NOTES !
Color Management is mostly thought of for printing color but the ICC standard has always 
included a grayscale format that can control the lightness/darkness tonality - essentially like a 
grayscale PhotoShop Curve.  Hardly anybody cared about this so it was not supported much. 
 QTR added some tools for creating grayscale ICCs way back.  They were a bit harder to use 
on Windows but on the Mac it all worked just like color profiles.  It all worked beautifully until 
CS4 - a long time ago.  Due to a lot of internal changes like 64-bit programs, the grayscale 
CM stopped working when printing from Photoshop to QTR driver.  I spent a lot of time with 
Apple and Adobe to have them fix this but no such luck. In fact later on they even made it 
hard on the color people by dropping No Color Management from Photoshop. So you 
couldn't print the color targets for making custom ICC profiles. All this led to me writing 
Print-Tool - first as a CM fix and then as a general easy to use layout program. 

Color Management has become increasingly difficult to understand. Conceptually its not that 
complicated but in practice its hard to know which component of the whole system is doing 
what, and how. In general there are 3 main CM players - the application (PhotoShop, 
Lightroom, Print-Tool, or something else), the operating system OS X (with Colorsync as 
Apple's Color Management System) and finally the driver (for example an Epson printer 
driver or QTR printer driver for B&W). Unfortunately they all want to get in on the act - but 
you need EXACTLY ONE to do the actual color management conversion. 

The concept is to print out a target with no color management happening, measure it and 
then create a profile. From that point on you print introducing ONLY THIS PROFILE into the 
print workflow. The important thing though is that all the settings while printing have to be 
IDENTICAL to those that were used when printing the original target. 

!
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Problems arise if you use different print settings: 

 ◦ if you print with different applications which might do different things,                    
 ◦ or if you print with a different OS something is probably different,                    
 ◦ or if you have a different driver version something may have been changed.                    
Not that all these things are likely to be a problem but sometimes, unpredictably, they are. 

In practice it usually depends from where the profile came. Epson profiles for Epson papers 
for a specific driver tend to work well. Downloaded profiles from someone/paper 
manufacturer are harder to know how they were made. A personal example for a custom 
paper showed one printer's profiles too light and one too dark. Profiles made with Print-Tool 
made both printers work correctly. 

It is important to always use OS X Print Presets to make sure you have consistent settings. 
CS6 is particularly tricky here because there are settings in the Preset and settings stored 
with the image. Make them all the same. Most of the settings show up on the Print Settings 
print dialog pane but the Color Matching pane can also be important. CS6 Manages Color 
will force Color Matching to ColorSync so if you want Print-Tool the same you should check 
this and make it ColorSync as well. If you have a working setup its hard to give a guaranteed 
answer - try various ways to see what works. Experimentation is the key. 

======================= 

QuadToneRIP versus Print-Tool 

On Mac there are now two separate products.  The long time QTR driver runs as an ordinary 
print driver in the OS. It’s a specialized print driver for B&W output. You can print with any 
program you like - naturally PhotoShop has been the usual. In late 2012 I introduced a new 
program for high level image layout. I've used the name QTR-Print-Tool but to be less 
confusing I’ve now dropped the QTR part of the name. Print-Tool is somewhat like the 
QTRgui front-end (for Windows) but its capabilities are a lot closer to something like 
Qimage.  Print-Tool and QTR are completely independent, so you can do PhotoShop to QTR 
driver, Print-Tool to QTR driver, or Print-Tool to Epson driver. 

======================= 

Roy Harrington 
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